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Handing Off Cost
Estimates

CostLink/CM Now Converts
CostLink/AE Projects

With this quarter’s release of BSD
CostLink®/CM and BSD CostLink®/AE,
CM is now capable of reading a CostLink/
AE project. This means you can begin a
project using AE’s unique modeling
capability to create an initial conceptual or
budget estimate (even before any significant
design development), carry that forward into
design development by using AE’s capabil-
ity to drag and drop alternative tasks and
assemblies into the model, and subsequently
convert that estimate into CM format for
further detailed development and reporting
during the construction documents phase.

CostLink/AE’s major strengths are its
modeling capability and its overall simplic-
ity, allowing development of detailed cost
estimates before any significant design work
has begun. CM, on the other hand, has
heavy-duty capabilities that include break-

Figure A - New Project Data Tab in SL Summary Info Dialog Box

Performance Improvements in BSD
SpecLink® and PerSpective®

Subscribers will notice a
distinct speed improve-
ment in the latest
releases of BSD
SpecLink and
PerSpective, due to
changes in the way the
link engine operates.
The speed improvement
is especially noticeable
in network situations
where the project being
edited is maintained on a
server.

The master database in
BSD SpecLink+
includes over 150,000
links that give the text its “intellect.” Active
links and the current status of each are
stored with the project, and there can be tens
of thousands of active links in a project. As
each paragraph is selected, any links
attached to it are activated, and these links
in turn can affect other paragraphs and
choices anywhere in the project, sometimes
resulting in a new cascade of links from
newly affected paragraphs. Prior to the
current release, resolution of these links
from a single selection sometimes involved
a series of round trips between the editing
CPU and the stored project. When the
project and the editor were on different
computers on a network, there were
sometimes delays in updating the link status.
These delays could also be exacerbated by
heavy network traffic, by computer speed,
and by the number of people sharing the
project database.

With the latest release, a new link manage-
ment scheme is in effect. To use the network
more efficiently, SpecLink and PerSpective

now maintain in memory on the local
computer a temporary copy of all status and
link information for the currently open
document. The link engine maintains this
temporary copy without any need to
communicate with the centrally stored
project database during the editing session.
When you change documents by clicking in
the navigation tree, the link engine updates
the central database with the in-memory
copy of the edited section and creates an in-
memory copy of the status and link informa-
tion for the next document selected. This
new process significantly reduces communi-
cation needs, thereby speeding up document
editing on network projects. Users who edit
and maintain their projects locally will also
see a lesser speed improvement.

The Tools menu in both programs now
includes a new “Save In-Memory Linking”
command that allows you to save the current
document status at any time. There is also a
new toggle command on the Tools menu for

See “Performance Improvements” on Page 4
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ing costs down into material, labor, equipment, and other types of
costs, and a full-blown reporting system, alternate work breakdown
views, individual contractor markups, and many other high-end
features. AE is bundled with RS Means installed cost data that
includes 70 cost models, 11,000 assemblies, and 20,000 line items.
CM, on the other hand, supports optional RS Means databases with
similar composition, but they are broken down by material and
labor, and they include the crew, labor and equipment resources for
each assembly and task.

To use the new conversion capability, simply use the File|Open
project command in CostLink/CM and choose the AE project that
you want to use in CM. After a confirmation message, the software
presents a dialog to let you specify the name and location for the
resulting CM project. The AE source project is not changed by the
conversion process and is still available for use in AE. However,
once converted there is no connection between the AE version and
the CM version of the project, and the CM version cannot be
opened in AE. During the conversion process, you are given an
opportunity to select the RS Means assembly or cost item database
you will be using as the reference database for the CM project and
subsequent editing in CM. AE uses the so-called “big” assemblies
RS Means database, so if you are using other Means assembly
databases in CM, they may not support all the assemblies in your
estimate. Unsupported assemblies will be converted to user-added

tasks. Similarly, if you choose a cost item database (which does not
include assemblies), assemblies will be converted to user-added
tasks—as will any cost items in your estimate that are not repre-
sented in the referenced cost item database.

Once you have converted a project from AE, there are a couple of
areas you will want to consider carefully—markups and quantities.
CM supports several types of sophisticated markups, whereas
CostLink/AE uses a simple set of markups applied to the bottom
line. The conversion assigns all items to a single prime contractor,
so you may want to make markup adjustments to the project in CM.
Quantities are another area worth examining. If you use a model in
AE, many quantities are dependent on a formula, and the formula is
not available in CM. Consequently, quantities will be set at the
values established by the model formulae at the time of conversion
and may need subsequent adjustment in CM.

New Custom Reports in CM:  The new release of CostLink/CM
includes four new custom reports that demonstrate the power of
CM’s custom reporting capability. The new reports are Bill of
Materials, Bill of Sales, Bill of Materials Quote Sheet and Bill of
Sales Quote Sheet. The release notes include step-by-step directions
for running them. The reports are sorted and combined by “source
tag,” which is the unique ID of a cost item that generally begins with
a two-digit code corresponding to its MasterFormat division
number. All of the new reports display costs as Cost to Prime, which
includes the bare costs plus sales tax, overtime, direct cost adjust-
ments, and subcontractor markups. They do not include the Prime’s
markups or any Owner Cost markups.

Detailed instructions for the conversion process and for running the
new custom reports are included in the release notes for the current
version of CM. Be sure to read the notes, and taking advantage of
these new capabilities will be a snap.
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Cost Savings!
BSD CostLink/AE and PerSpective are being offered with

special initial purchase pricing through December 31st. Contact
BSD at 1-800-875-0047 for details.

What Our Users Have to Say about SpecLink®+
“I’m one of SpecLink’s biggest fans! The new import feature has made it possible for me to
create sections VERY easily, and I’m still learning (with the help of your support staff) how to
do new and better things with it.  I am also pleased to see new sections coming along that
support sustainable (“green”) building design.  Thanks for continually improving the system,
it makes my spec writing much easier and more pleasant.”
Sam Austin - Senior Project Manager at C.M. Architecture, P.A., Fort Worth, Texas

“I just started using SpecLink and I like it very much.  The program is living up to all of my
expectations!  [SpecLink] is very easy to use and the need for training will be minimal here in
our office.”
Bill Cooke - Larson Consulting Group, Anchorage, Alaska

“We have recently used SL+ on two jobs and produced our two best specs ever.  Using
SpecLink helped us to include things we might have overlooked otherwise.”
Jason Krebsbach - Joseph P. Larrivee Architects, Bismarck, North Dakota
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Once MasterFormat 2004 has been published, BSD intends to
provide a vehicle for an automated transition that will allow our
users to move to the new MasterFormat on a project by project
basis.  BSD’s database automation should allow automatic conver-
sion of existing projects from the old edition to the new one when
the regular quarterly update is installed. This conversion will be
accomplished through the creation of a “map” in the database that
will relate the new numbering scheme to the old. We may even be
able to convert user-added sections automatically, provided they
comply with the ranges
established in the 1995 edition
of MasterFormat. Existing
projects that are not updated
will continue to use the old
MasterFormat numbering
scheme, but all new and
updated projects in SpecLink
and PerSpective will conform
to the new MasterFormat.

Finally, as indicated on the
front cover of The Hitchhiker’s
Guide to the Galaxy: Don’t
Panic! SpecLink and
PerSpective are ideally
structured to allow a seamless,
painless transition as the
industry moves to adopt the
new MasterFormat.

LinkLine
A BSD SoftLink® Publication

Editor: Laura Gemmell

The LinkLine is published by
Building Systems Design, Inc.
3520 Piedmont Road, NE
Suite 415
Atlanta, GA 30305

Permission to use excerpts in
other publications is granted
provided the publisher is notified
in advance at 404-365-8900.

BSD SpecLink, BSD CostLink
and BSD SoftLink are registered
trademarks, and BSD CadLink
and BSD LinkMan are all
trademarks of Building Systems
Design, Inc.

Get the latest on BSD by visiting
our web page at
www.bsdsoftlink.com

MasterFormat 2004 and BSD SpecLink®

Adopting New Numbering Should Be a Seamless, Painless Transition

All section numbers and titles in BSD SpecLink and the Products
(short form) catalog of PerSpective® are based on CSI’s
MasterFormat™ 1995 edition. After several years in development
and several drafts, the planned 2004 edition of MasterFormat is now
coming into focus, and many people in the construction industry are
understandably interested, if not concerned, about the potential
impact the very significant changes in MasterFormat will have on
their work. BSD’s subscribers, for instance, are unnecessarily
worried about the impact of the planned changes on their office
master specifications.

Until now, we have chosen not to say anything definitive to our
customers. However, in early November CSI published the pro-
posed final revision (Draft 4) for public review at www.csinet.org
and intends to finalize the document by mid-December. Publication
is tentatively scheduled for late 2004. We feel relatively comfortable
about addressing the topic of the MasterFormat revolution at this
time, since we assume relatively few additional changes will be
made between now and its final publication.

First of all, the familiar 16 divisions have been expanded to 49
divisions. Although many topics in Divisions 2 through 14 will
remain in their approximate locations in the expanded scheme, the
familiar 5-digit section numbering scheme has been changed to a
six-digit numbering scheme. This means that every single section
number and a great many section titles will change. In BSD
SpecLink, it also means that thousands of cross references within
the database will have to be changed. Of course, this is also true for
Masterspec®, Spectext®, and other specification systems such as the
Unified Facilities Guide Specifications published by NASA and the
military services. However, BSD SpecLink (and PerSpective) are
likely to be the only master specification systems capable of an
automated transition, because of their database structure.

About Your SpecLink & PerSpective Updates
SpecLink+ Statistics:

• 701 sections total

• 6 new generic sections

• 452 generic sections

• 1 new proprietary section

• 249 proprietary sections

PerSpective Statistics:

• 177 chapters

• 25,633 paragraphs

• 45,069 links

• 4,081 notes to specifier

• 614 external documents referenced

• 108,924 active paragraphs

• 138,781 internal links (targets and
consequences)

• 18,131 notes to specifier

• 2,086 external documents referenced

• 221 standards organizations referenced
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“Use In-Memory Linking” that allows you to turn this feature
on or off (the default setting is On). With this release, you will
not be able to use the Links dialog box when in-memory
linking is in effect. In-memory linking is not applicable and
therefore is not available for checked-out sections. This new
in-memory link management feature will not affect batch
processes like importing, printing, or copying.

SpecLink subscribers will also notice a change in the Summary
Info dialog box this quarter. There is a new Project Data tab
(see Page 1, Figure A) that allows you to record information
about your project in addition to its name and number,
including building type and location, gross square footage, and
bid and completion dates. There is also a checkbox to Release
Project Data, allowing project information to be publicized. In
the future, this feature will allow BSD to produce reports for
manufacturers and suppliers who have been specified as
acceptable in your projects. Of course, the entry of any
information on this tab and the decision to check the Release
Project Data checkbox are completely voluntary.

“Performance Improvements” from Page 1

02621 CertainTeed Foundation Drainage Piping Combination Foundation Drainage, Radon Venting, and Footing
Formwork

04080 ........................................ Hohmann & Barnard ...................... Masonry Reinforcement Systems .................................. Seismic-Rated Masonry Reinforcement
04095 ........................................ Masonry Tech, Inc ......................... Masonry Weeps and Moisture Control .......................... Polystyrene Masonry Weeps and Moisture Control
05511 ........................................ Alaco Ladder .................................. Metal Ladders ................................................................ Aluminum Ladders
05520 ............... 05721 ............. American Railing ........................... Handrails and Railings ................................................... Ornamental Railings
05520 ............... 05723 ............. Moultrie Mfrg Co ........................... Handrails and Railings ................................................... Ornamental Pipe Railings
05522 ............... 05724 ............. Taco Metals .................................... Tempered Glass Railing Assemblies ..............................
05720 ............... 05722 ............. C.S. Johnson .................................. Ornamental Handrails and Railings ............................... Custom Railings With Cable Infill
06210 ............... 06151 ............. CertainTeed .................................... Wood Decking ................................................................ Wood Polymer-Composite Decking
10171 ............... 06621 ............. Comtec ........................................... Solid Plastic Compartments and Vanity Counters ......... Solid Plastic Vanity Counters
07185 ........................................ Ensurco Duradek ............................ Traffic Membrane ........................................................... PVC Sheet Deck Membrane
07222 ........................................ Atlas Roofing ................................. Roof Board Insulation .................................................... Polyisocyanurate Roof Board Insulation
07320 ............... 07322 ............. Ludowici ........................................ Roof Tiles ....................................................................... Clay Roof Tiles
07320 ............... 07322 ............. Guiraud Freres ............................... Roof Tiles ....................................................................... French Clay Roof Tiles
07410 ............... 07411 ............. McElroy Metal ............................... Metal Roof and Wall Panels .......................................... Uninsulated Metal Roof and Wall Panels
07410 ............... 07415 ............. Metl-Span ....................................... Metal Roof and Wall Panels .......................................... Insulated Metal Roof and Wall Panels
07411 ............... 07431 ............. Kanalco .......................................... Metal Wall Panels .......................................................... Aluminum-Composite Wall Panels
07411 ............... 07431 ............. Mitsubishi Alpolic .......................... Metal Wall Panels .......................................................... Aluminum-Composite Wall Panels
07411 ........................................ STEELOX ...................................... Metal Roof Panels .......................................................... Standing Seam Metal Roof Panels
07411 ........................................ US Steel .......................................... Metal Roof Panels .......................................................... Aluminum-Zinc Alloy Coated Roof Panels
07461 ........................................ Louisiana Pacific ............................ Wood Siding ................................................................... Oriented Strandboard
07463 ........................................ Alcoa .............................................. Aluminum Siding ............................................................ Aluminum Siding, Soffits, and Trim
07610 ............... 07411 ............. Petersen Aluminum ........................ Sheet Metal Roofing ...................................................... Uninsulated Metal Roof, Wall, and Soffit Panels
08110 ............... 08111 ............. Benchmark ..................................... Steel Doors and Frames ................................................. Insulated Steel Doors and Frames
08305 ........................................ G-U Hardware ................................ Sliding Glass Doors ....................................................... Lift-Sliding and Sliding-Folding Glass Doors
08342 ........................................ Fib-R-Dor ....................................... Fiberglass Doors and Frames ......................................... All-Fiberglass Doors and Frames
08840 ............... 08842 ............. Polygal, Inc. ................................... Plastic Glazing ............................................................... Cellular Plastic Glazing
09300 ............... 09301 ............. Endicott .......................................... Tile .................................................................................. Clay Tile and Stair Treads
09640 ............... 09644 ............. Mintec ............................................ Wood Flooring ................................................................ Bamboo Plank Flooring
09640 ............... 09643 ............. Buell ............................................... Wood Flooring ................................................................ Engineered Wood Plank Flooring
09800 ............... 09851 ............. Eckel ............................................... Acoustical Treatment ..................................................... Metal Faced Acoustical Panels
09800 ............... 09852 ............. Golterman & Sabo ......................... Acoustical Treatment ..................................................... Acoustical Panels, Baffles, Diffusers, and Reflectors
09982 ........................................ SGM ............................................... Cementitious Coatings ................................................... Cementitious Coating
10300 ............... 10306 ............. Heat-N-Glo ..................................... Fireplaces and Stoves ..................................................... Gas-Burning Fireplaces and Stoves
10500 ............... 10505 ............. Comtec ........................................... Lockers ........................................................................... Polyethylene Lockers
12498 ............... 08875 ............. V-Kool ............................................ Solar Control Film .......................................................... Solar Control Film
10605 ............... 10606 ............. Wire-Crafters ................................. Wire Mesh Partitions ..................................................... Wire Mesh Partitions and Railings
13851 ........................................ BSD ................................................ Fire Alarm System - Protected Premises ....................... Fire Alarm System
13852 ........................................ Fike ................................................. Fire Alarm System .......................................................... Fire Alarm System Equipment
14100 ............... 14110 ............. Vincent Whitney ............................. Dumbwaiters .................................................................. Manual Dumbwaiters
15080 ............... 15088 ............. Knauf .............................................. Mechanical Insulation .................................................... Fiberglass Mechanical Insulation

original # new # company original title new title

BSD SpecLink® Sections with Number and/or Title Changes*

*BSD SpecLink® Section Changes
Our usage statistics tell us that our subscribers tend to prefer the BSD non-
proprietary sections to proprietary sections when there is a choice. How-
ever, our database also includes many proprietary sections for specialty
products not included in BSD sections, and our subscribers do use many of
those sections. As a result of our usage analysis, we have made a number of
changes to BSD’s section list this quarter, as you can see by glancing at the
top of this page and the next.

We have eliminated many proprietary sections that were used very rarely.
In most cases, these duplicated content in BSD sections, or there were
multiple sections sponsored by different manufacturers. We have also
renamed and/or renumbered a group of proprietary sections to reflect their
content more accurately. Finally, we have added several non-proprietary
sections to take the place of some of the proprietary sections being
eliminated this quarter. Of course, if any of the sections being removed or
moved are in a project you wish to update, you will be given the opportu-
nity during the update process to convert them to user-added sections.
Master notes will not be copied during the update conversion, so to avoid
this problem, simply copy these sections to user-added sections prior to
installing the update.
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this type of skylight is generally used where other skylight types won’t
fit, the light transmission characteristics are better than normal
skylights and can mean significant energy savings — review manufac-
turers’ literature for details.

08871 BSD - Safety and Security Glazing Film
Prescribes performance criteria and other relevant characteristics of
transparent plastic glazing film for safety glazing and blast resistance.
For safety glazing, section assumes that existing annealed glass is
being retrofit to achieve 16 CFR 1201 Category II and ANSI Z97.1
performance. For blast resistance, film may be applied to both new and
existing glazing. This section does not contain all information neces-
sary to determine the performance criteria for blast resistance.

09513 BSD - Fabric-Faced Acoustical Ceilings
Specialty fabric-faced, fiberglass ceiling panels for use in suspended
metal ceiling grids. Grids may be specified in this section or in a
separate section.

10242 BSD - Rooftop Equipment Screens
Aluminum screens for concealing rooftop equipment; includes both
louvered and flat picket type screens that allow air movement.
Supporting structure is not included in this section and must be
specified elsewhere, typically in 05500 - Metal Fabrications.

02832 BSD - Segmental Retaining Walls
Segmental modular concrete units and accessory materials designed
for retaining wall use. Wall relies on gravity and shear resistance to
resist overturning. This section does not cover site preparation,
dewatering, shoring, excavation not associated with retaining walls,
or finish grading.

07464 BSD - Vinyl Siding
Vinyl siding, soffit, and trim. Residential vinyl siding of all types,
including horizontal and vertical, clapboard, dutchlap, and beaded;
board and batten; and simulated shingles and shakes; soffit as linear
“boards” or large panels. If needed for retrofit work, specify a vapor
retarder in the section for installation over existing sheathing.

08625 BSD - Tubular Skylights
Residential and commercial rigid reflective tubular skylights. Although

06621 COM - Solid Plastic Vanity Counters
Comtec Industries; solid high density polyethylene and polypropylene.
www.comtecindustries.com

New Proprietary Section

New Generic Sections

these sections have been removed refer to section*
08830 - Mirrors (Palmer) .................................................................. 08830
09110 - Non-Loadbearing Wall Framing (Dietrich) .......................... 09111 and 09260
09260 - Gypsum Board Assemblies (National Gypsum) .................. 09260
09622 - Rubber Recreational and Athletic Flooring  (Pawling Corp) 09625
09640 - Wood Flooring (Gammapar) ................................................ 09643 BUE
10155 - Toilet Compartments (Global Steel) .................................... 10160, 10165, and 10170
10160 - Metal Toilet Compartments (Hadrian) ................................. 10160
10165 - Plastic Laminate Toilet Compartments (Marlite) ................. 10165
10171 - Solid Plastic Toilet Compartments (Capitol Partitions) ....... 10170
10186 - Solid Plastic Shower/Dressing Room Compartments

 (Capital Partitions) .............................................................. 10170
10191 - Cubicle Curtains (InPro Corp) ............................................. 10191
10260 - Wall and Corner Guards (InPro Corp) ................................. 10260
10305 - Manufactured Fireplaces (Superior Fireplace) ..................... 10305
10350 - Flagpoles (Concord Industries) ........................................... 10350
10500 - Lockers (Penco Products) .................................................... 10500
10605 - Wire Mesh Partitions (Acorn Wire & Iron Works) .............. 10605
10650 - Operable Partitions (Modernfold) ....................................... 10651
13032 - Saunas (Amerec, Baltic Leisure, Finlandia,

Helo, and McCoy) ............................................................... 13032
13034 - Steam Rooms (Amerec, Helo, and McCoy) ........................ 13034
13100 - Lightning Protection (National Lightning Protection,

both Safety First and Prevectron) ......................................... 13100
13966 - Total Flooding Extinguishing System (FIKE) ...................... 13966
13980 - Sprinkler Piping Cover Assemblies (Grice Engineering) ..... 13980 CRS
14120 - Electric Dumbwaiters (Waupaca Elevator Co.) ................... 14100
14240 - Hydraulic Elevators (Kone) ................................................. 14202 and 14201
15054 - Water Soluble Flux (Taracorp/IMACO) .............................. 15145
15055 - Plumbing Solder (Taracorp/IMACO) .................................. 15145
15102 - Copper/Copper Alloy Building Services Piping

(Copper Dev. Assoc.) ........................................................... 15145, 15182, 15184,  and
............................................................................................. 15186

15831 - Air Doors/Air Curtains (Berner) .......................................... 15831
*all referenced sections are bsd non-proprietary sections
unless otherwise indicated

BSD SpecLink® Sections Removed This Quarter; Please Refer to Sections Indicated*

these sections have been removed refer to section*
02834 - Modular Concrete Retaining Walls (Anchor Wall

Systems, Keystone , Rockwood, Tensar, and Versa-Lok) .... 02832 (NEW)
03400 - Precast Concrete (Shockey Precast) .................................... 03411, 03415, and
.......................................................................................................... 03451

03490 - Glass Fiber Reinforced Concrete (Stromberg Arch. Products) 03455
04210 - Clay Masonry Units (Endicott Clay) 04810, 04811, 04815,

04816, 04820, and 04840
04720 - Cast Stone (Stromberg Architectural Products) ................... 04720
05311 - Non-Composite Steel Form Deck (US Steel) ...................... 05310
05312 - Composite Steel Deck (US Steel) ........................................ 05310
05313 - Steel Roof Deck (US Steel) ................................................. 05310
05400 - Cold Formed Metal Framing (CEMCO and Dietrich) ......... 05400
05520 - Handrails and Railings (Swedge Lock, UltraGuard and

Ensurco Duradek) ................................................................ 05721 ARS
05522 - Tempered Glass Railing Assemblies (ACI Distribution) ..... 05724 TMI
05715 - Fabricated Spiral Stairs (Duvinage and Stairways, Inc.) ...... 05715
07162 - Crystalline Waterproofing (Xypex) ...................................... 07162
07240 - Exterior Insulation and Finish System (Sto) ........................ 07240
07463 - Aluminum Soffits and Trim (NAPCO and Variform) ........... 07463 ALC
07464 - Vinyl Siding (Alcoa, CertainTeed, Heartland, LP, Mastic,

NAPCO, Variform, Wolverine) ............................................ 07464
07610 - Sheet Metal Roofing (Englert) ............................................. 07411 PAC
08110 - Steel Doors and Frames (CECO, Republic Builders, SDI,

Steelcraft, Marlite) ............................................................... 08110
08115 - Steel Door Frames (REDIFRAME) ..................................... 08115
08120 - Aluminum Doors and Frames (Dor-O-Matic) ...................... 08120
08211 - Flush Wood Doors (Buell Door Co.) ................................... 08211
08212 - Stile and Rail Wood Doors and Frames (Buell Door Co.) ... 08212
08213 - Plastic Laminate Faced Doors (Buell Door Co. and Marlite) 08211
08330 - Coiling Doors and Grilles (Atlas and Wayne-Dalton) ......... 08331 and 08332
08360 - Overhead Doors (Ideal Door and Wayne-Dalton) ............... 08360
08365 - Upward-Acting Sectional Doors (Amarr Garage Doors) .... 08360
08520 - Aluminum Windows (St. Cloud Window, Inc.) .................... 08520
08630 - Metal-Framed Skylights (Solar Innovations) ....................... 08630
08810 - Glass (Pilkington Libbey Owens Ford and Visteon Glass) .. 08800
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All Products
How can I find out what has changed
in the software on this update CD?

Read the release notes, which change
every quarter.  You can open the

release notes by going to the Install Prod-
ucts screen on the update CD and clicking
the link for the Release Notes under the
product you have.  If you are downloading
the software from the website instead of
receiving a CD, go to www.bsdsoftlink.com
and click on the Download center option on
the left side.  Look for What’s New to find
the release notes for each product.

How do I add icons to the toolbar?

To add icons to your toolbar, right
click on the toolbar and choose

Customize.  The Customize dialog box will
open.  Click on the Tools tab.  On the left
side, click on the name of the category that
contains the command you are looking for
(for example, for Insert Task you would
click on the Insert category).  On the right
side, scroll to find the command, and then
drag it to the place you want it on the
toolbar.  It’s easier to place if you put it
somewhere in the middle instead of at the
end.  While the Customize dialog box is
open, you can also move any other icons to
more convenient locations, or remove
unused icons by dragging them to the
middle of your screen.

CostLink AE and CM
I have a client that requires
UniFormat to start with but then later

he wants the estimate in CSI MasterFormat?
Can I do that?

CostLink CM can do that for you
automatically if your cost items have

the CSI division numbers as the first two
characters in the Source Tag.  Start your
project using one of the UniFormat tem-

plates and complete the estimate.  When you
need to see the project in CSI
MasterFormat, change your view drop down
to Project CSI view.  Then go to the
LinkMan menu and choose Assign Tasks by
Hierarchy.  Accept the default selections and
click OK.  You can then change the Report
Hierarchy in the Reports Setup dialog box
to use the CSI hierarchy for reporting or
exporting.

I appreciate being able to use a
project template with the folders

already defined, rather than having to create
them from scratch.  The only problem is that
my estimates end up with lots of empty
folders that don’t have cost items in them.
Is there a way to get rid of them other than
deleting them one by one?

Yes. When you have finished adding
cost items to your estimate, click on

the Tools menu, and then choose Delete
Empty Folders.  This will remove any
folders that do not have tasks.  Level One
folders must be deleted manually.

I don’t see the Models tab in my
CostLink/AE project.  How can I

make use of the new modeling feature?

In order to use any of the 70 RS
Means building Cost Models, you

need to start a project using the new
template called Uniformat II Project
Template with Models.MPJ.  Once you have
a project started with this template, you will
have both the Cost Models and the Model
Additives tabs in the Summary Info dialog
box.

Can I import a CostLink/AE project
into CostLink/CM?

Starting with the Winter 2003
version, CostLink/CM now includes

a feature to allow you to convert a
CostLink/AE project into CostLink/CM.  If
you have a current RS Means Assemblies
database for CostLink/CM, then the
converted project will use that as the
referenced database in the CostLink/CM
project and will match up as many assem-
blies as it can find.  If you do not have the
RS Means Assemblies database for
CostLink/CM, then the assemblies will be

converted as user line items.  In either case,
if you are converting a CostLink/AE model,
the quantities for the assemblies and tasks
will no longer be driven by the CostLink/AE
model quantities.  For more information, see
the CostLink/CM release notes.

SpecLink & PerSpective
I have several user-added paragraphs
that I would like to move to another

section or chapter in the same project.  How
do I move them?

The best way to move several
paragraphs of text at a time is to drag

across the text of the paragraphs with your
mouse so that they all turn black in the
background, and then click the Cut button.
(If they are master paragraphs, and not user-
added, you can choose Copy instead.)  In
the section or chapter where you want to
move the paragraphs, click to place your
cursor in the paragraph that will follow the
cut (or copied) paragraphs, and click on the
Paste button.  All the text is copied at the
location of your cursor, pushing down the
original text at that spot.

I am using SpecLink and we do quite
a few small projects in which 1

section of Masonry would be much less
work to write.  We have to write 3-4
sections to call out standard concrete block,
its reinforcing, its mortar, etc.  The same is
true for brick.  Can you help me with this?

To produce a single section for all
masonry, including brick, CMU, and

mortar, you should use 04810BSD - Unit
Masonry Assemblies.

Other individual non-proprietary sections
are for situations when a lot of detail is
required and a single section would be too
long.  The BSD non-proprietary sections
are:

04065 - Mortar and Masonry Grout
04811 - Single-Wythe Unit Masonry
04812 - Glass Unit Masonry
04815 - Cavity Walls
04820 - Reinforced Unit Masonry

(not in 04810)
04840 - Prefabricated Masonry Panels

(not in 04810)
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discovered the acronym will default to
“USER”).

The Section/Chapter Title is expected to be
the second non-blank line in the
document.  A properly delimited note
(see below) may precede the Section
Title (but not the Section ID); the note
will be assigned to the Section Title.

The file name is irrelevant; it is not used to
determine either the number or the
acronym (or the title).

Any or all of the above information can be
edited in the dialog box following file
selection.

Paragraphs beginning with the word “Part”
and one of the words “General”,
“Products” or “Execution” will import
at Level 1.  The text is not case-
sensitive.

Other levels (hierarchy) are determined
basically by the amount of space
between the left margin and the first
printable character on the line,
regardless of how the space was
created.

Since SpecLink+/PerSpective have their
own auto-numbering system, the import
from RTF attempts to remove numbers
and letters from the beginning of a line.
From the beginning of a line up to five
characters followed by a tab will be
recognized as an auto-number to be
removed.

When a paragraph is indented 2 or more
levels below its parent it will be
promoted until it is only one level
below its parent.

Lines beginning with 10 or more asterisks
will be recognized as the boundary
beginning or ending text that should be
treated as a Note to the following
paragraph.

For more information, see the release notes
from the Summer 2003 BSD SoftLink CD.

the text in the Summary Information screen,
the green text will change throughout the
project to your replacement term.  Please
note that you may insert choices only in
user-added paragraphs.

I have some sections in Word format
that I am trying to bring into my

project.  What is the most efficient way to
do that?

The newly added feature Add New
Section/Chapter from RTF is the

fastest way to create a new section.  This
allows you to create a new section by
importing an RTF file, without first creating
the section in SpecLink+ or PerSpective.
(RTF stands for Rich Text Format, which is
readable by multiple applications.  To make
an RTF file, open the Word document and in
Word from the File menu choose Save As.
Change the Save as Type dropdown to Rich
Text Format (RTF).)  If you have a file you
can import, you don’t need to start the
document in SpecLink+/PerSpective first
and you don’t need to remove the para-
graphs that you don’t need from the new
section/chapter.  There are two settings on
the Tools menu that need to be set correctly
before you use Add New Section/Chapter
from RTF.  If you have Auto-Select New
Paragraphs turned on, then all paragraphs
imported during the Add New Section/
Chapter from RTF will be selected with a
checkmark.  There is a new menu selection
called Look for Choice Fields in Import.  If
this is turned on (reflected by a checkmark
in the menu choice) then the import will
create choices within the section/chapter.  If
the Look for Choice Fields in Import is not
turned on, then the software will not create
choices in your section/chapter and brackets
will import as brackets, for example.

The Rules:

The word “Section” for SpecLink or
“Chapter” for PerSpective must be in
the first non-blank line in the document.

This word must be followed by one or more
spaces followed by the Section/Chapter
ID number.

The number must be five characters in
length and may be followed without
space by an acronym (If no acronym is

More questions?
Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com

The current proprietary sections are:
04080 - Hohman and Barnard reinforcement
04085 - Heckman anchors and accessories
04090 - Polytite flashings
04095 - Masonry Technology accessories

I would like to change the formatting
of an entire section or chapter, but

not save a user-defined style.

If you would like to turn off the
automatic numbering for an entire

section or chapter, first select the text of all
the paragraphs.  To do that, click to place
your cursor to the left of the first letter in the
first paragraph (the title paragraph) in the
chapter or section.  Then hold down the Ctrl
and Shift keys on your keyboard while you
press the End key.  The background of all
the paragraphs should turn black.  From the
Document menu choose No AutoNumber.
If you want to change the font for a para-
graph, or part of a section or chapter, you
have to apply it for each selected paragraph.
Apply the desired format using the toolbar
above the Document panel.

I will be creating a number of front-
end documents for my office master

and I will need to mention a term in them
that changes from project to project.  Is
there any way to easily change that term
without finding and editing it in each
document where it appears?

There are replaceable terms in the
Summary Information screen that

you can use to change information through-
out the documents.  If the term you need is
not one of those listed, there are keywords
that are not used in any of the master
documents that you can use for your term
instead.  In PerSpective, the keyword
Design Professional is not used in any of the
chapters.  In SpecLink, the keyword Design-
Builder is not used in any of the sections.
Just edit the text in Summary Information to
whatever term you need.  Then, click in the
paragraph where you want that term to
appear, and from the Document menu
choose Choices...Add Choice.  From the
Choice Group Type drop-down, select the
keyword that you used, click the Add
button, and then click the OK button.  The
term will appear in green text.  If you edit
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BSD SpecLink+
Either Day*  $495
Both Days*  $895

December 1-2

2004 Dates
January 20-21
March 16-17

April 6-7
June 22-23
July 20-21

AIA Members: Submit Course Completion
Certificate for 7 or 14 Continuing Education

Units
CSI Members: Submit Course Completion
Certificate for 7 or 14 Education Contact

Hours (ECHs) toward your CCS, CCCA, or
CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/CM
3-1/2 days*  $1295

2004 Dates
January-Date TBA

March 2-5
June 29-July 2

September 21-24
December 14-17

AIA Members: Submit Course Completion
Certificate for 24 Continuing Education Units

CSI Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at 8:30 AM on Tuesday morning
and ends at 11:30 AM on Friday.

The BSD SpecLink+
Workshop

The BSD SpecLink+ Workshop consists of
two one-day workshops.  The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
within the software, start a new project, edit
sections, understand how the links and
choices work, and how to format, print and
export the final document.  It is designed
for new users.  The second day is designed
for those who want to learn how to create
and maintain their own office master.  This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, as well as cre-
ating your own Wizards.  Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions and information on travel, hotels, and Atlanta!


